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SUMMARY: 36 
This protocol describes a dynamic culture system to produce controlled size aggregates of human 37 
pluripotent stem cells and further stimulate differentiation in cerebellar organoids under 38 
chemically-defined and feeder-free conditions using a single-use bioreactor. 39 
 40 
ABSTRACT:  41 
The cerebellum plays a critical role in the maintenance of balance and motor coordination, and 42 
a functional defect in different cerebellar neurons can trigger cerebellar dysfunction. Most of the 43 
current knowledge about disease-related neuronal phenotypes is based on postmortem tissues, 44 
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which makes understanding of disease progression and development difficult. Animal models 45 
and immortalized cell lines have also been used as models for neurodegenerative disorders. 46 
However, they do not fully recapitulate human disease. Human induced pluripotent stem cells 47 
(iPSCs) have great potential for disease modeling and provide a valuable source for regenerative 48 
approaches. In recent years, the generation of cerebral organoids from patient-derived iPSCs 49 
improved the prospects for neurodegenerative disease modeling. However, protocols that 50 
produce large numbers of organoids and a high yield of mature neurons in 3D culture systems 51 
are lacking. The protocol presented is a new approach for reproducible and scalable generation 52 
of human iPSC-derived organoids under chemically-defined conditions using scalable single-use 53 
bioreactors, in which organoids acquire cerebellar identity. The generated organoids are 54 
characterized by the expression of specific markers at both mRNA and protein level. The analysis 55 
of specific groups of proteins allows the detection of different cerebellar cell populations, whose 56 
localization is important for the evaluation of organoid structure. Organoid cryosectioning and 57 
further immunostaining of organoid slices are used to evaluate the presence of specific cerebellar 58 
cell populations and their spatial organization.  59 
 60 
INTRODUCTION:  61 
The emergence of human pluripotent stem cells (PSCs) represents a excellent tool for 62 
regenerative medicine and disease modeling, because these cells can be differentiated into most 63 
cell lineages of the human body1,2. Since their discovery, PSC differentiation using diverse 64 
approaches has been reported to model different diseases, including neurodegenerative 65 
disorders3–6. 66 
 67 
Recently, there have been reports of 3D cultures derived from PSCs resembling human cerebral 68 
structures; these are called brain organoids3,7,8. The generation of these structures from both 69 
healthy and patient-specific PSCs provides a valuable opportunity to model human development 70 
and neurodevelopmental disorders. However, the methods used to generate these well-71 
organized cerebral structures are difficult to apply for their large-scale production. To produce 72 
structures that are large enough to recapitulate tissue morphogenesis without necrosis inside 73 
the organoids, protocols rely on the initial neural commitment in static conditions, followed by 74 
encapsulation in hydrogels and subsequent culture in dynamic systems3. However, such 75 
approaches may limit the potential scale-up of organoid production. Even though efforts have 76 
been made to direct PSC differentiation to specific regions of the central nervous system, 77 
including cortical, striatal, midbrain, and spinal cord neurons9–12, the generation of specific brain 78 
regions in dynamic conditions is still a challenge. In particular, the generation of mature 79 
cerebellar neurons in 3D structures has yet to be described. Muguruma et al. pioneered the 80 
generation of culture conditions that recapitulate early cerebellar development13 and recently 81 
reported a protocol that allows for human embryonic stem cells to generate a polarized structure 82 
reminiscent of the first trimester cerebellum7. However, the maturation of cerebellar neurons in 83 
the reported studies requires the dissociation of the organoids, sorting of cerebellar progenitors, 84 
and coculture with feeder cells in a monolayer culture system7,14–16. Therefore, the reproducible 85 
generation of the desired cerebellar organoids for disease modeling under defined conditions is 86 
still a challenge associated with culture and feeder source variability.  87 
 88 
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This protocol presents optimal culture conditions for 3D expansion and efficient differentiation 89 
of human PSCs into cerebellar neurons using single-use vertical wheel bioreactors (see Table of 90 
Materials for specifications), hereafter called bioreactors. Bioreactors are equipped with a large 91 
vertical impeller, which in combination with a U-shaped bottom, provide a more homogeneous 92 
shear distribution inside the vessel, allowing gentle, uniform mixing and particle suspension with 93 
reduced agitation speeds17. With this system, shape and size-controlled cell aggregates can be 94 
obtained, which is important for a more homogeneous and efficient differentiation. Moreover, a 95 
larger number of iPSC-derived organoids can be generated in a less laborious manner. 96 
 97 
The main feature of the organoids, which are 3D multicellular structures usually formed from 98 
stem cells, is the self-organization of different cell types that forms specific shapes like those seen 99 
in human morphogenesis18–20. Therefore, organoid morphology is an important criterion to be 100 
evaluated during the differentiation process. Cryosectioning of organoids and further 101 
immunostaining of organoid slices with a specific set of antibodies allow for the spatial 102 
visualization of molecular markers to analyze cell proliferation, differentiation, cell population 103 
identity, and apoptosis. With this protocol, by immunostaining organoid cryosections, an initial 104 
efficient neural commitment is observed by the 7th day of differentiation. During differentiation, 105 
several cell populations with cerebellar identity are observed. After 35 days in this dynamic 106 
system, the cerebellar neuroepithelium organizes along an apicobasal axis, with an apical layer 107 
of proliferating progenitors and basally located postmitotic neurons. During the maturation 108 
process, from days 35–90 of differentiation, distinct types of cerebellar neurons can be seen, 109 
including Purkinje cells (Calbindin+), granule cells (PAX6+/MAP2+), Golgi cells (Neurogranin+), 110 
unipolar brush cells (TBR2+), and deep cerebellar nuclei projection neurons (TBR1+). Also, a 111 
nonsignificant amount of cell death is observed in the generated cerebellar organoids after 90 112 
days in culture.  113 
 114 
In this system, human iPSC-derived organoids mature into different cerebellar neurons and 115 
survive for up to 3 months without the need for dissociation and feeder coculture, providing a 116 
source of human cerebellar neurons for disease modeling.  117 
 118 
PROTOCOL:  119 
 120 
1. Passaging and maintenance of human iPSCs in monolayer culture 121 
 122 
1.1. Preparation of plates 123 
 124 
1.1.1. Thaw the basement membrane matrix (see Table of Materials) stock at 4 °C and prepare 125 
60 μL aliquots. Freeze the aliquots at -20 °C. 126 
 127 
1.1.2. To coat the wells of a 6 well plate, thaw one aliquot of the basement membrane matrix on 128 
ice. Once thawed add 60 µL to 6 mL of DMEM-F12. Gently resuspend by pipetting up and down. 129 
 130 
1.1.3. Add 1 mL of diluted basement membrane matrix solution to each well of a 6 well plate and 131 
incubate at RT for at least 1 h before passaging or store at 4 °C for up to 1 week. 132 
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 133 
1.2. Passaging of iPSC colonies with EDTA 134 
 135 
1.2.1. Maintain iPSCs in monolayer culture in 6 well plates in the incubator at 37 °C, 95% 136 
humidity, and 5% CO2.  137 
 138 
NOTE: In this protocol, three distinct human iPSC lines were used: F002.1A.1321, human episomal 139 
iPSC line (iPSC6.2)22, and commercially obtained iPS-DF6-9-9T.B (see Table of Materials).  140 
 141 
1.2.2. Before passaging, incubate the stored plates (step 1.1) at room temperature (RT) for 15 142 
min and prepare the mTesR1 medium (Table 1). 143 
 144 
1.2.3. Aspirate the solution from the plate using a serological pipette and immediately add 0.5 145 
mL of mTeSR1 medium to each well. 146 
 147 
1.2.4. Aspirate the spent medium from the well containing iPSCs and wash once using 1 mL of 148 
0.5 mM EDTA per well. 149 
 150 
1.2.5. Add 1 mL of 0.5 mM EDTA to each well and incubate at RT for 5 min. 151 
  152 
1.2.6. Aspirate EDTA and remove the cells from the wells by gently adding mTeSR1 medium and 153 
pipetting the colonies using a P1000 micropipette. Collect the cells in a conical tube.  154 

 155 
NOTE: Do not pipette cells up and down more than 3x. 156 
 157 
1.2.7. Add 1 mL of cell suspension (diluted 1:4) to each well so that each well contains 1.5 mL of 158 
medium after the cell suspension is added. Return cells to the incubator at 5% CO2, 37 °C. 159 
 160 
1.2.8. Replace the spent medium daily and passage every 3 days when 75%–80% confluence is 161 
achieved. 162 
 163 
2. Seeding of human iPSCs in the bioreactor 164 
 165 
2.1. Incubate iPSCs grown as monolayers in mTeSR1 supplemented with 10 µM of ROCK inhibitor 166 
Y-27632 (ROCKi). Add 1 mL of supplemented medium to each well from a 6 well tissue culture 167 
plate and incubate for 1 h in at 37 °C, 95% humidity, and 5% CO2.  168 
 169 
NOTE: ROCKi is used to protect dissociated iPSCs from apoptosis23. 170 
 171 
2.2. After 1 h of incubation, aspirate the spent medium from each well and wash 1x with 1 mL of 172 
1× PBS per well.  173 
 174 
2.3. Add 1 mL of the cell detachment medium (see Table of Materials) to each well of a 6 well 175 
plate and incubate at 37 °C for 7 min until cells detach easily from the wells with gentle shaking. 176 



   

Page 4 of 17   
 

 177 
2.4. Pipette the cell detachment medium up and down with a P1000 micropipette until the cells 178 
detach and dissociate into single cells. Add 2 mL of complete cell culture medium to each well to 179 
inactivate enzymatic digestion and pipette the cells gently into a sterile conical tube. 180 
 181 
2.5. Centrifuge at 210 × g for 3 min and remove the supernatant.  182 
 183 
2.6. Resuspend the cell pellet in culture medium (i.e., mTeSR1 supplemented with 10 µM of 184 
ROCKi) and count the iPSCs with a hemocytometer using trypan blue dye. 185 
 186 
2.7. Seed 15 × 106 single cells in the bioreactor (maximum volume of 100 mL) with 60 mL of 187 
mTeSR1 supplemented with 10 µM of ROCKi at a final cell density of 250,000 cells/mL.  188 
 189 
2.8. Insert the vessel containing the iPSCs in the universal base unit placed in the incubator at 37 190 
°C, 95% humidity, and 5% CO2.  191 

 192 
NOTE: The bioreactor stirring is maintained for 24 h by setting the universal base unit control to 193 
27 rpm to promote iPSC aggregation. 194 
 195 
3. Differentiation and maturation of human iPSC-derived aggregates in cerebellar organoids 196 
 197 
3.1. Define the day of single cell seeding as day 0.  198 
 199 
3.2. On day 1, collect 1 mL of the iPSC aggregates sample using a serological pipette. Maintain 200 
the bioreactor under agitation as before by placing the universal base unit with the bioreactor 201 
containing the aggregates in a sterile flow prior to collecting the sample. Plate the cell suspension 202 
in an ultralow attachment 24 well plate. Check that iPSC-derived aggregates are formed.  203 
 204 
3.3. Acquire images with an optical microscope using a total magnification of 40x or 100x to 205 
measure aggregate diameter.  206 
 207 
3.4. Measure the area of the aggregates in each image using FIJI software.  208 

 209 
3.4.1.  Select “Analyze | Set Measurements” from the menu bar and click on “Area” and “OK”.  210 
 211 
3.4.2. Select “File | Open” from the menu bar to open a stored image file. Select the line selection 212 
tool presented in the tool bar and create a straight line over the scale bar presented in the image. 213 
Select “Analyze | Set scale” from the menu bar.  214 

 215 
3.4.3. In “Known distance” add the expanse of the image's scale bar in µm. Define the “Unit of 216 
length” as µm. Click on “Global” to maintain the settings and “OK”. Select Oval Selection in the 217 
tool bar.  218 

 219 
3.4.4. For each aggregate delineate the area with the oval tool. Select “Analyze | Measure”. 220 
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Calculate their diameter based on measured area, considering that aggregates are approximately 221 
spherical using 222 
 223 

diameter = √4A
𝜋⁄   224 

 225 
with A as the area of the aggregate.  226 
 227 
3.5. When the average diameter of the aggregates is 100 µm, replace 80% of the spent medium 228 
with fresh mTeSR1 without ROCKi. When aggregates reach 200–250 μm in diameter, replace all 229 
the spent medium with gfCDM (Table 1), letting the organoids settle at the bottom of the 230 
bioreactor. 231 
 232 
NOTE: If the average aggregate diameter exceeds 350 μm do not start the differentiation 233 
protocol. Repeat the seeding of single cells. Generally, it takes around 1 day for the aggregate to 234 
reach an average diameter of 100 µm.  235 
 236 
3.6. Insert the bioreactor containing the aggregates in the universal base unit placed in the 237 
incubator at 37 °C, 95% humidity, and 5% CO2.  238 
 239 
3.7. Decrease the bioreactor agitation to 25 rpm. 240 
 241 
3.8. On day 2, repeat steps 3.2, 3.3, and 3.4 to evaluate the aggregate diameter. Add 30 μL of 242 
FGF2 (final concentration, 50 ng/mL) and 60 μL of SB431542 (final concentration, 10 μM) to 60 243 
mL of gfCDM differentiation medium (Table 1). Replace all spent medium from the bioreactor 244 
with the supplemented gfCDM. Repeat step 3.6. 245 

 246 
NOTE: SB431542 is crucial to inhibit mesendodermal differentiation, inducing neural 247 
differentiation24. FGF2 is used to promote the caudalization of the neuroepithelial tissue25. 248 
 249 
3.9. On day 5, repeat steps 3.2, 3.3, 3.4, and 3.8. 250 
 251 
NOTE: Aggregate size should increase during the differentiation protocol. However, the diameter 252 
is only critical when the differentiation starts, because this parameter could influence the efficacy 253 
of differentiation. 254 
 255 
3.10. On day 7, repeat steps 3.2, 3.3, and 3.4. Dilute FGF2 and SB431542 to 2/3: Add 20 μL of 256 
FGF2 and 40 μL of SB431542 to 60 mL of gfCDM differentiation medium. Replace all spent 257 
medium from the bioreactor with supplemented gfCDM. Repeat step 3.6 and increase bioreactor 258 
agitation to 30 rpm. 259 
 260 
3.11. On day 14, repeat steps 3.2, 3.3, and 3.4. Add 60 μL of FGF19 (final concentration, 100 261 
ng/mL) to 60 mL of gfCDM differentiation medium. Replace all spent medium from the bioreactor 262 
with gfCDM supplemented with FGF19. Repeat step 3.6. 263 
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 264 
NOTE: FGF19 is used to promote polarization of mid-hindbrain structures26. 265 
 266 
3.12. On day 18, repeat steps 3.2, 3.3, 3.4, and 3.11.  267 
 268 
3.13. On day 21, repeat steps 3.2, 3.3, and 3.4. Replace all spent medium from the bioreactor 269 
with complete neurobasal medium (Table 1). Repeat step 3.6.  270 

 271 
NOTE: Neurobasal medium is a basal medium used to maintain the neuronal cell population 272 
within the organoid7. 273 
 274 
3.14. On day 28, repeat steps 3.2, 3.3, and 3.4. Add 180 μL of SDF1 (final concentration, 300 275 
ng/mL) to 60 mL of complete neurobasal medium. Replace all spent medium from the bioreactor 276 
with complete neurobasal medium supplemented with SDF1. Repeat step 3.6. 277 
 278 
NOTE: SDF1 is used to facilitate the organization of distinct cell layers27. 279 
 280 
3.15. On day 35, repeat steps 3.2, 3.3, and 3.4. Replace all spent medium from the bioreactor 281 
with complete BrainPhys medium (Table 1). Repeat step 3.6. 282 
 283 
NOTE: BrainPhys is a neuronal medium that supports synaptically active neurons28. 284 
 285 
3.16. Replace 1/3 of the total volume every 3 days with complete BrainPhys medium until day 90 286 
of differentiation.  287 
 288 
4. Preparation of organoids for cryosectioning and immunohistochemistry 289 
 290 
4.1. Collection of organoids for immunostaining 291 
 292 
4.1.1. Collect 1 mL of sample of medium containing organoids with a serological pipette from the 293 
bioreactor to a 15 mL conical tube.  294 
 295 
NOTE: Organoids should be collected at different timepoints to evaluate the efficacy of 296 
differentiation, including days 7, 14, 21, 35, 56, 70, 80, and 90. 297 
 298 
4.1.2. Remove the supernatant and wash once with 1 mL of 1× PBS.  299 

 300 
NOTE: Do not centrifuge the organoids. Let the organoids settle at the bottom of the tube by 301 
gravity. 302 
 303 
4.1.3. Remove the supernatant and add 1 mL of 4% paraformaldehyde (PFA). Incubate at 4 °C for 304 
30 min. Remove the spent PFA and add 1 mL of 1× PBS. 305 
 306 
4.1.4. Store the organoids in 1 mL of 1× PBS at 4 °C until processing for cryosectioning.  307 
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 308 
NOTE: Store the organoids in 1x PBS for no more than 1 week after fixation.  309 
 310 
4.2. Preparation of organoids for cryosectioning 311 
 312 
4.2.1. Remove the supernatant from the stored organoids. Add 1 mL of 15% sucrose (w/v, diluted 313 
in 1× PBS), mix well by gentle swirling, and incubate overnight at 4 °C. 314 
 315 
4.2.2. Prepare a solution of 15% sucrose/7.5% gelatin (Table 2) and maintain at 37 °C during 316 
preparation to avoid gelatin to solidify.  317 
 318 
4.2.3. Remove the 15% sucrose solution, add 1 mL of 15% sucrose/7.5% gelatin to the organoids, 319 
and quickly mix by gentle swirling. Incubate at 37 °C for 1 h. 320 
 321 
4.2.4. Add 15% sucrose/7.5% gelatin solution to a plastic container up to half of its volume. Wait 322 
for solidification at RT. 323 
 324 
4.2.5. After a 1 h incubation, carefully place a sucrose/gelatin drop containing the organoids on 325 
the solidified gelatin with a Pasteur pipette. Leave to solidify at RT for about 15 min. Make sure 326 
to avoid bubble formation. 327 
  328 
4.2.6. Place 15% sucrose/7.5% gelatin on top of the organoids until the container is filled. Wait 329 
for complete solidification at RT. 330 
 331 
4.2.7. After solidification, incubate 20 min at 4 °C.  332 
 333 
4.2.8. Cut the gelatin into a cube containing the organoids in the center and fix the gelatin cube 334 
on a piece of cardboard with a drop of O.C.T. compound.  335 
 336 
4.2.9. Place 250 mL of isopentane in a 500 mL cup and fill an appropriate container with liquid 337 
nitrogen. Using forceps and thick gloves, carefully place the cup containing isopentane on the 338 
surface of liquid nitrogen and cool the isopentane to -80 °C. 339 
 340 
4.2.10. When -80 °C is reached, place the gelatin cube into the cup containing isopentane until it 341 
freezes, keeping the temperature at -80 °C. Depending on the size of the cube, it might take 1–2 342 
min.  343 

 344 
NOTE: Avoid temperatures below -80 °C or excessive freezing time, because it might cause 345 
cracking of the cube.  346 
 347 
4.2.11. When frozen, quickly store the gelatin cube at -80 °C and store until cryosectioning.  348 
 349 
4.3. Cryosectioning of organoids 350 
 351 
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4.3.1. Turn on the cryostat and define both specimen (OT) and cryochamber (CT) temperatures 352 
at -25 °C. 353 
 354 
4.3.2. When both temperatures stabilize, fix the gelatin cube containing the organoids on the 355 
specimen by using O.C.T. compound.  356 
 357 
4.3.3. Define section thickness at 12 µm.  358 
 359 
4.3.4. Cut the cube and collect 3–4 slices on adhesion microscope slides (see Table of Materials). 360 
 361 
4.3.5. Store at -20 °C until use.  362 
 363 
4.4. Immunostaining of organoids slices 364 
 365 
4.4.1. Place the microscope slides containing organoid sections in a copling jar with 50 mL of 366 
prewarmed 1x PBS, holding up to 10 slides back-to-back.  367 
 368 
NOTE: All organoid sections should be submerged with liquid.  369 
 370 
4.4.2. Incubate for 45 min at 37 °C to degelatinize slides. 371 
 372 
4.4.3. Wash 1x with 50 mL of 1× PBS for 5 min at RT: Transfer the slides to a copling jar containing 373 
fresh 1× PBS. 374 
 375 
4.4.4. Transfer the slides to a copling jar containing 50 mL of freshly prepared glycine (Table 2) 376 
and incubate for 10 min at RT. 377 
 378 
4.4.5. Transfer the slides to a copling jar containing 50 mL of 0.1% triton (Table 2) and 379 
permeabilize for 10 min at RT. 380 
 381 
4.4.6. Wash with 1× PBS for 5 min 2x.  382 
 383 
4.4.7. Prepare the immunostaining dish with 3 mm paper soaked in 1× PBS. Dry slides with a 384 
tissue all around the slices and place them onto 3 mm paper. With a Pasteur pipette, cover the 385 
whole surface of the slides with blocking solution (Table 2) with ~0.5 mL per slide. Incubate for 386 
30 min at RT. 387 
 388 
4.4.8. Remove excess blocking solution and dry the slides with a tissue all around the slices. Place 389 
50 µL of the primary antibody (Table 3) diluted in blocking solution over the sections and cover 390 
with the coverslips. Place the slices in a previously prepared immunostaining dish. Incubate 391 
overnight at 4 °C. 392 
 393 
4.4.9. Transfer the slides to a copling jar with 50 mL of TBST (Table 2), let the coverslips fall, and 394 
wash with TBST for 5 min 3x. 395 
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 396 
4.4.10. Place 50 µL of the secondary antibody diluted in blocking solution over the sections and 397 
cover with the coverslips. Place the slices in the previously prepared immunostaining dish. 398 
Incubate for 30 min at RT, protected from light. 399 
 400 
4.4.11. Transfer the slides to a copling jar again and wash with 50 mL of TBST for 5 min 3x. 401 
 402 
4.4.12. Dry the slides with a tissue all around the slices and place the slices in a previously 403 
prepared immunostaining dish. Add 0.5 mL of DAPI solution over the whole surface of the slides 404 
with a Pasteur pipette. Incubate for 5 min at RT. 405 
 406 
4.4.13.  Repeat step 4.4.9. 407 
  408 
4.4.14. Carefully dry the slides with a tissue. Add 50 µL of mounting medium drop by drop along 409 
the slide and then carefully lower a coverslip onto each slide, slightly bending it to avoid bubbles.  410 
 411 
REPRESENTATIVE RESULTS:  412 
The protocol was initiated by promoting cell aggregation using the 0.1 L bioreactors (Figure 1A). 413 
Single cell inoculation of the iPSCs was performed, with 250,000 cells/mL seeded in 60 mL of 414 
medium with an agitation speed of 27 rpm. This was defined as day 0. After 24 h, the cells 415 
efficiently formed spheroid-shaped aggregates (day 1, Figure 1B), and the morphology was well-416 
maintained until day 5, with a gradual increase in size, demonstrating a high degree of 417 
homogeneity in aggregate morphology and size over time. (Figure 1B). A quantitative analysis by 418 
microscopy also revealed normal distribution of aggregate sizes by day 1 (Figure 1C). The 419 
aggregate size is an important physical parameter capable of prompting the cells to differentiate 420 
toward different lineages29,30. For this reason, based on the aggregate size reported in previous 421 
studies to induce an efficient neural31,32 and cerebellar commitment21, the generated aggregates 422 
were maintained in mTeSR1 medium at 25 rpm until they reached the desired diameter before 423 
starting differentiation (~200 µm). At day 2, the average diameter was 221.0 ± 54.4 µm (mean ± 424 
SD) for the F002.1A.13 cell line and 212.1 ± 42.1 µm for the iPSC6.2 cell line. As such, both cell 425 
lines attained the optimal aggregate size at this timepoint (Figure 1C).  426 
 427 
Defining the day on which the seeding of iPSCs was performed as day 0, at day 2, after achieving 428 
the desired aggregate diameter, neural commitment was induced by simultaneously using 429 
SB431542, FGF2, and insulin, promoting neuroectodermal differentiation, as well as a moderate 430 
caudalization necessary for mid-hindbrain patterning. Afterwards, FGF19 and SDF1 were added 431 
to the culture at days 14 and 28, respectively, to promote the generation of different cerebellar 432 
progenitors. For the first days of neural induction, a rotation speed of 25 rpm was used, which 433 
was increased to 30 rpm after 7 days to avoid the accumulation and clumping of bigger 434 
aggregates (Figure 2A). During differentiation, organoids showed a more pronounced 435 
epithelization similar to neural tube-like structures with luminal space (Figure 2B). Additionally, 436 
the evaluation of organoid diameter distribution demonstrated a homogeneous size distribution 437 
during the initial cerebellar commitment until day 14 (Figure 2B).  438 
 439 
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Immunofluorescence analysis supports that an efficient neural commitment of the iPSC-derived 440 
organoids is already achieved by day 7 of differentiation after adding FGF2 and SB431542. The 441 
cryosections of organoids revealed many structures reminiscent of the neural tube staining for 442 
PAX6 and NESTIN, with most cells within the organoids expressing progenitor marker NESTIN at 443 
days 7 and 14 of differentiation (Figure 2C). Afterwards, FGF19 and SDF1 promoted the 444 
generation of continuously proliferating progenitor layers (PAX6+) and an efficient neuronal 445 
differentiation was achieved, as demonstrated by the expression of TUJ1, neuron-specific class 446 
III beta-tubulin, by days 21 and 35 (Figure 2C). In addition, an efficient cerebellar differentiation 447 
was also observed after 21 days in the 0.1 L VW bioreactors, demonstrated by the presence of 448 
two different cell populations: granule cell progenitors (BARLH1+ cells, Figure 3A), and Purkinje 449 
cell progenitors (OLIG2+ cells, Figure 3B). After 35 days in culture, different cell populations within 450 
the organoids appeared to be organized into distinct layers. Various flat-oval structures within 451 
the organoids were observed with BARHL1+ dorsal cerebellar progenitors as a continuous layer 452 
on the superficial side of the organoid (Figure 3C,D) and SOX2+ in the luminal region of these oval 453 
structures (Figure 3D). In addition, TUJ1+ newborn neurons appeared to migrate towards the 454 
surface, reestablishing the radial alignment on the outer surface of the organoid (Figure 3E).  455 
 456 
After the generation of cerebellar progenitors, further maturation was promoted using BrainPhys 457 
medium28 supplemented with neurotrophic factors BDNF and GDNF. Immunofluorescence 458 
staining of organoid cryosections was used to detect distinct subtypes of cerebellar neurons. 459 
Purkinje cells, GABAergic neurons expressing the calcium-binding protein calbindin (CALB, Figure 460 
3F), were detected in the cerebellar organoids after the maturation protocol. In addition, another 461 
major cerebellar neuronal type, granule cells, was identified as a subset of cells coexpressing 462 
PAX6 and MAP2 (Figure 3G). Interestingly, a pool of PAX6+ progenitors not expressing MAP2 was 463 
maintained until 80 days of differentiation. Other types of cerebellar neurons were also detected, 464 
including unipolar brush cells expressing TBR2 (Figure 3H), and deep cerebellar nuclei projection 465 
neurons expressing TBR1 (Figure 3I). In addition to efficient cerebellar differentiation and 466 
maturation, this 3D dynamic culture system using the PBS 0.1 L VW bioreactors allowed 467 
organoids to remain viable for up to 90 days, without significant cell death and necrosis (Figure 468 
3J).  469 
 470 
FIGURE AND TABLE LEGENDS:  471 
Figure 1. Generation of size-controlled aggregates using scalable bioreactors. (A) Design 472 
features of the bioreactor. (B) Brightfield photomicrograph showing aggregates from two 473 
different iPSC lines on days 1, 2, and 5. Scale bar = 100 μm. (C) The size distribution of floating 474 
aggregates from different iPSC lines in the bioreactors. 475 
 476 
Figure 2. Generation of human iPSC-derived organoids using 0.1 L bioreactors. (A) Schematic 477 
representation of the culture procedure to induce differentiation of iPSCs to cerebellar 478 
organoids. Cells were seeded at a density of 250,000 cells/mL and an agitation speed of 27 rpm 479 
was used to promote cell aggregation. During the first days of differentiation, aggregates were 480 
maintained at an agitation speed of 25 rpm. Afterwards, to avoid the accumulation of bigger 481 
aggregates, the agitation speed was increased to 30 rpm. (B) Characterization of organoid shape 482 
and size. Brightfield photomicrographs showing iPSC-derived organoids during cerebellar 483 
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differentiation in the 0.1 L VW bioreactors. Scale bar = 100 μm. The distribution of organoid 484 
diameters demonstrates that the culture maintained homogeneous organoids sizes along the 485 
differentiation protocol. (C) Efficient neural induction in iPSC-derived organoids. 486 
Immunofluorescence for NESTIN, PAX6, and TUJ1 during cerebellar differentiation. Scale bar = 50 487 
μm. 488 
 489 
Figure 3. Efficient cerebellar differentiation and maturation in human iPSC-derived organoids. 490 
(A-E) Efficient cerebellar commitment. Immunostaining analysis for BARHL1, SOX2, OLIG2, NCAD, 491 
and TUJ1 markers at indicated timepoints of the cerebellar differentiation protocol. (F-I) Efficient 492 
maturation of human iPSC-derived cerebellar organoids. Immunofluorescence showing different 493 
types of cerebellar neurons, including Purkinje cells (CALB, F), granule cells (PAX6 and MAP2, G), 494 
unipolar brush cells (TBR2), and deep cerebellar nuclei projections neurons (TBR1). (J) High cell 495 
viability after cerebellar maturation. Live/dead (calcein-AM, green and propidium iodide, red) 496 
staining of organoids showed high cell viability and no evidence of necrotic areas after 80 days in 497 
the bioreactors. Scale bar = 50 μm. 498 
 499 
Table 1. Stock solutions and media preparation. Listed are all the components and volumes used 500 
to prepare media for the iPSCs maintenance and differentiation protocol, as well as stock 501 
solutions of growth factors and small molecules. For stock solutions, all stock concentration and 502 
protocols for reconstitution are listed.  503 
 504 
Table 2. Solutions for preparation of organoids for cryosectioning and immunostaining. Listed 505 
are all the components and volumes used to prepare the solutions used in the preparation of 506 
organoids for cryosectioning and immunostaining. 507 
 508 
Table 3. Primary antibodies. The primary antibodies, clone, and optimized dilutions used for 509 
immunostaining are listed.  510 
 511 
DISCUSSION:  512 
The need for large cell numbers as well as defined culture conditions to generate specific cell 513 
types for drug screening and regenerative medicine applications has been driving the 514 
development of scalable culture systems. In recent years, several groups have reported the 515 
scalable generation of neural progenitors and functional neurons32–34, providing significant 516 
advances in the development of new models for neurodegenerative disorders. Nonetheless, the 517 
recapitulation of some critical events of embryonic development is still lacking, and the 518 
maintenance of the generated functional neurons in suspension for long periods of time has not 519 
yet been achieved34. Presented here is a dynamic 3D culture system able to generate iPSC-520 
derived neural organoids with cerebellar identity, and to further promote maturation into 521 
functional cerebellar neurons under chemically-defined and feeder-free conditions in dynamic 522 
culture.  523 
 524 
Before starting cerebellar differentiation, it is critical to maintain the quality of the human iPSCs. 525 
Thus, in order not to compromise the differentiation, no more than three passages of iPSCs 526 
should be performed from thawing to bioreactor inoculation. An important step in the 527 
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differentiation protocol is to evaluate the aggregate size. The aggregate size has a critical role in 528 
inducing differentiation towards a specific cell lineage29. Besides that, there is a minimum size 529 
threshold that appears to favor differentiation35. As already reported, the optimal iPSC-derived 530 
aggregate diameter to promote an efficient neural commitment31,32 and cerebellar 531 
differentiation21 is a ~200 µm diameter.  532 
 533 
Additionally, in this dynamic protocol, the agitation speed used in the first days of culture is 534 
crucial to control the aggregate diameter and neural induction. The culture started at 27 rpm, 535 
which is sufficient to promote iPSCs aggregation and to avoid the formation of larger aggregates 536 
(diameters above 350 µm should be avoided). The agitation used to promote cell aggregation 537 
after single cell seeding could be increased to 30 rpm without affecting cell viability; however, 538 
higher agitation speeds are expected to produce smaller aggregates. Depending on the iPSC line, 539 
24 h after cell seeding using 27 rpm, two different scenarios are expected: the aggregates formed 540 
present smaller diameters (<200 µm) or have reached a range of sizes between 200–300 µm. If 541 
aggregates are larger than 350 µm at 24 h after cell seeding, differentiation should not be 542 
performed, and the cell seeding should be repeated, because the efficiency of the differentiation 543 
will be very low. If aggregates are smaller than 200 µm, the spent medium should be replaced 544 
with iPSC maintenance medium, and the agitation speed reduced to 25 rpm. With this 545 
adjustment, aggregate diameter is expected to increase from day 1 to day 2, probably due to the 546 
merging of individual aggregates promoted by the decrease in the agitation speed. In case of 547 
aggregates with sizes between 200–300 µm, the spent medium should be replaced with 548 
differentiation medium, and neural induction with FGF2 should be started after 2 days in culture. 549 
At this point, the agitation speed should also be slightly reduced to prevent excessive cell death, 550 
because cells are more sensitive to shear stress in the presence of differentiation medium. 551 
Additionally, the population homogeneity could be analyzed using the coefficient of variation 552 
(CV), which measures the variability by correlating standard deviation with the mean of 553 
aggregate diameters, according to the equation 554 
  555 

𝐶𝑣= 𝛿⁄μ 556 
 557 
in which δ represents the standard deviation of the aggregate diameter and μ is the average 558 
diameter. In this dynamic system, the observed average CV was 12.5 ± 3.3% (mean ± SD) for the 559 
F002.1A.13 cell line and 19.0 ± 0.37% for the iPSC6.2 cell line at day 2. Thus, in this system, a 560 
homogeneous size population with a CV below 0.2 (< 20% of variation) should be expected. After 561 
7 days of differentiation, the average aggregate diameter ranged from 300–360 µm, and the 562 
agitation speed was increased to 30 rpm to prevent aggregates to settle at the bottom of the 0.1 563 
L VW bioreactor. 564 
 565 
The differentiation of cerebellar organoids until day 35 and the analysis of aggregate size in static 566 
conditions were recently reported21. The authors showed that 3D aggregates formed and 567 
maintained in plates (e.g., Aggrewell) until day 7 of differentiation were homogeneous in size and 568 
shape21. However, after transferring the aggregates to ultralow attachment 6 well culture plates, 569 
the aggregates started to vary in size and morphology21. On day 35 in static conditions, some of 570 
the 3D aggregates reached 1,000 μm for different cell lines, which limited the diffusion of 571 
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nutrients and oxygen. In contrast, using our dynamic conditions, aggregates did not reach more 572 
than 800 μm in diameter by day 35, with improved mass transfer due to the constant agitation 573 
of the medium promoted by the vertical wheel. Furthermore, the aggregate sizes were 574 
maintained until the end of the maturation process, showing an aggregate diameter of 646.6 ± 575 
104.2 μm by day 90, the longest culture performed in 0.1 L VW bioreactors.  576 
 577 
Efficient cerebellar induction was induced by sequential addition of SB431542, FGF2, FGF19, and 578 
SDF1 in this 3D dynamic system. The protocol starts with the combination of SB431542, which is 579 
a transforming growth factor beta (TGF-ß)-receptor blocker that inhibits mesendodermal 580 
differentiation, and FGF2, which has a major effect in the caudalization of neuroepithelial 581 
tissue25. Therefore, the addition of these two molecules during the first days of culture is essential 582 
to promote the cell differentiation to the mid-hindbrain, the territory that gives rise to the 583 
cerebellar tissue. After initial induction to mid-hindbrain tissue, it is necessary to add FGF19 for 584 
promoting the spontaneous generation of mid-hindbrain structures with dorsal-ventral polarity, 585 
as well as the generation of different cerebellar progenitors36,26. SDF1 facilitates the organization 586 
of distinct layers of cerebellar progenitors, as seen at the developmental stage in which cerebellar 587 
neurogenesis occurs27. Until day 35, these molecules can promote the organization of cerebellar 588 
organoids that can recapitulate human cerebellar development, which corresponds to the first 589 
trimester cerebellum. After the organization of cerebellar progenitors into different layers, a 590 
defined neuronal medium was used to promote their maturation28. Other media used to 591 
maintain neuronal cells could also be tested, but lower efficiencies are anticipated. Thus, in this 592 
protocol, BrainPhys was used to promote the differentiation of cerebellar-committed cells into 593 
cerebellar neurons, because it has been reported to better mimic the healthy neuronal 594 
environment and to support neurophysiological activity of the generated neurons28.  595 
 596 
Using these dynamic conditions, a more efficient diffusion of nutrients, oxygen, and growth 597 
factors can be achieved. However, some limitations are associated with the agitation used in the 598 
differentiation protocol. Some shear stress can be introduced by the agitation process, which can 599 
affect the survival, proliferation, and differentiation of cells. Therefore, during the maturation 600 
step, in which the cells are more sensitive, the culture must be carefully monitored. 601 
 602 
The differentiation of cerebellar organoids reminiscent of human embryonic cerebellar 603 
development has already been reported7. However, further maturation of these embryonic 604 
cerebellar organoids into cerebellar neurons using 3D cultures remains a challenge. The 605 
generation of functional cerebellar neurons was only achieved by coculturing with granule cells 606 
from various sources4,7,15. This protocol successfully upscaled cerebellar commitment of human 607 
iPSCs; in addition, this is the first protocol for the differentiation of different cerebellar neurons 608 
in a 3D culture system without coculturing with feeder cells. Specifically, the following cell types 609 
can be produced in our dynamic culture system: Purkinje cells (Calbindin+), granule cells 610 
(PAX6+/MAP2+), unipolar brush cells (TBR2+), and deep cerebellar nuclei projection neurons 611 
(TBR1+), which were maintained in suspension for as long as 3 months. 612 
 613 
The scalable generation of cerebellar organoids represents a valuable tool for studying the 614 
embryonic development of the cerebellum and the pathological pathways involved in the 615 
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degeneration of this organ. Furthermore, high-throughput screening for molecules that restore 616 
cerebellar function may be performed using organoids obtained with this scalable system. 617 
Overall, this method satisfies an unmet need for a scalable protocol for the generation of high-618 
quality cerebellar organoids that may be important for a variety of biomedical applications. 619 
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mTeSR1

Final volume: 500 mL

gfCDM (growth factor-free chemically defined medium)

Final volume: 60 mL 

Neurobasal

Final volume: 60 mL 

Complete BrainPhys

Final volume: 60 mL  

Basic fibroblast growth factor (bFGF/FGF2) 

Stock concentration: 100 µg/mL

Stromal cell-derived factor 1 (SDF1)

Stock concentration: 100 µg/mL

Brain-derived neurotrophic factor (BDNF) 

Stock concentration: 100 µg/mL

Glial cell-derived neurotrophic factor (GDNF)

Stock concentration: 100 µg/mL

Fibroblast growth factor 19 (FGF19) 

Stock concentration: 100 µg/mL

ROCK inhibitor Y-27632

Stock concentration: 10mM 

SB431542

Stock concentration: 10mM 
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Insulin 

Stock concentration: 10 mg/mL
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1. Thaw mTeSR1 5× supplement at room temperature (RT) or at 4 °C overnight and mix with basal medium

2. Store complete mTeSR1 medium at 4 °C for up to 2 weeks or prepare 40 mL aliquots and store at -20 °C 

3. Pre-warm complete mTeSR1 at RT before use

30 mL Ham’s F12

30 mL IMDM

600 µL chemically defined lipid concentrate (1 % v/v)

2.4 µL monothioglycerol (450 μM)

30 µL apo-transferrin (stock solution at 30 mg/mL in water, final concentration: 15 μg/mL)

300 mg crystallization-purified BSA (5 mg/mL)

42 µL insulin (stock concentration at 10 mg/mL, final concentration: 7 µg/mL)

300 µL P/S (0.5% v/v, 50 U/ml penicillin/50 μg/ml streptomycin)

60 mL of Neurobasal medium

600 µL N2 supplement

600 µL Glutamax I 

60mL of BrainPhys

1.2 mL NeuroCult SM1 Neuronal Supplement

600 µL N2 Supplement

12 µL BDNF (final concentration: 20 ng/mL)

12 µL GDNF (final concentration: 20 ng/mL)

300 µL Dibutyryl-cAMP (stock concentration: 100 mg/mL in water, final concentration: 1 mM)

42 µL ascorbic acid (stock concentration: 50 µg/mL in water, final concentration: 200 nM)

1. Reconstitute in 5 mM Tris, pH 7.6, at a concentration of 10 mg/mL 

2. Dilute with 0.1 % BSA in PBS (v/v) to a final stock concentration of 100 µg/mL

1. Reconstitute in 5 mM sodium phosphate, pH 7.4, at a concentration of 10 mg/mL 

2. Dilute with 0.1 % BSA in PBS (v/v) to a final stock concentration of 100 µg/mL

1. Reconstitute in water at a concentration of 10 mg/mL

2. Dilute with 0.1 % BSA (v/v) in PBS to a final stock concentration of 100 µg/mL.

Reconstitute in DMSO at a concentration of 10 mM.



1. Reconstitute 10 mg of insulin in 300 µL of 10 mM NaOH 

2. Carefully add 1 M NaOH until the solution becomes clear-transparent 

3. Fill to 1 mL with sterile water.



Gelatin/Sucrose

Final concentration: 7.5%/15% w/w

Glycine

Final concentration: 0.1 M

Triton solution

Final concentration: 0.1 % w/v

TBST 

20 mM Tris-HCl pH 8.0, 150 mM NaCl, 0.05 % 

w/v Tween-20

Blocking Solution

DAPI solution

Mowiol
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1. Weigh 15 g of sucrose and 7.5 g of gelatin in a sterile Schott Glass Bottle and mix 

well 

2. Pre-warm the PBS 1× at 65 °C

3. Add pre-warmed PBS 1× to a final weight of 100 g and mix well

4. Place the Schott Glass Bottle in a heating plate at 65 °C and shake until the 

gelatin melts 

5. Incubate at 37 °C until the solution stabilizes 

Add 0.37 g glycine to 50 mL of freshly-prepared PBS 1×.

1. Prepare a 10 % Triton X-100 stock: 5 g of Triton X-100 in 50 mL of PBS 1× 

2. Add 0.5 mL of Triton X-100 stock to 50 mL of PBS 1×. 

20 mL Tris 1 M 

30 mL NaCl 5 M

5 mL Tween-20 (10 % stock: 5 g of Tween-20 in 50 mL water)

Fill to 1 L with water.

Add 5 mL of fetal bovine serum (FBS, final concentration: 10 % v/v) to 50 mL of

TBST.

Add 15 µL of DAPI stock solution (1 mg/mL) to 10 mL of destilated water

1. Add 2.4 g of Mowiol to 6 g of glycerol and shake for 1 h in a pre-warmed plate at 

50 °C

2. Add 6 mL of distilled water and shake for 2 h

3. Add 12 mL of Tris 200 mM (pH 8.5) and shake for 10 min

4. Centrifuge at 5,000 × g for 15 min

5. Aliquot and store at -20 °C. 



Antibody Host species Dilution

BARHL1 rabbit 1/500

CALBINDIN rabbit 1/500

MAP2 mouse 1/1000

N-CADHERIN mouse 1/1000

NESTIN mouse 1/400

OLIG2 rabbit 1/500

PAX6 rabbit 1/400

SOX2 mouse 1/200

TBR1 rabbit 1/200

TBR2 rabbit 1/200

TUJ1 mouse 1/1000
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Name of Material/ Equipment Company Catalog Number

3MM paper WHA3030861 Merck 

Accutase A6964 - 500mL Sigma 

Anti-BARHL1 Antibody HPA004809 Atlas Antibodies 

Anti-Calbindin D-28k Antibody CB28 Millipore

Anti-MAP2 Antibody M4403 Sigma 

Anti-N-Cadherin Antibody 610921 BD Transduction

Anti-NESTIN Antibody MAB1259-SP R&D

Anti-OLIG2 Antibody MABN50 Millipore

Anti-PAX6 Antibody PRB-278P Covance

Anti-SOX2 Antibody MAB2018 R&D

Anti-TBR1 Antibody AB2261 Millipore

Anti-TBR2 Antibody ab183991 Abcam

Anti-TUJ1 Antibody 801213 Biolegend

Apo-transferrin T1147 Sigma 

BrainPhys Neuronal Medium N2-A & SM1 Kit 5793 - 500mL  Stem cell tecnhnologies

Chemically defined lipid concentrate 11905031 ThermoFisher

Coverslips 24x60mm 631-1575 VWR 

Crystallization-purified BSA 5470 Sigma 

DAPI 10236276001 Sigma

Dibutyryl cAMP SC- 201567B -500mg Frilabo

DMEM-F12 32500-035 ThermoFisher

Fetal bovine serum A3840001 ThermoFisher

Gelatin from bovine skin G9391 Sigma 

Glass Copling Jar E94 ThermoFisher

Glutamax I 10566-016 ThermoFisher
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Glycine MB014001 NZYtech

Ham’s F12 21765029 ThermoFisher

Human Episomal iPSC Line A18945 ThermoFisher

IMDM 12440046 ThermoFisher

Insulin 91077C Sigma 

iPS DF6-9-9T.B WiCell

Iso-pentane PHR1661-2ML Sigma 

L-Ascorbic acid A-92902 Sigma 

Matrigel 354230 Corning

Monothioglycerol M6154 Sigma 

Mowiol 475904 Millipore

mTeSR1 85850 -500ml  Stem cell technologies

N2 supplement 17502048 ThermoFisher

Neurobasal 12348017 ThermoFisher

Paraformaldehyde 158127 Sigma

PBS-0.1 Single-Use Vessel SKU: IA-0.1-D-001 PBS Biotech

PBS-MINI MagDrive Base Unit SKU: IA-UNI-B-501 PBS Biotech

Recombinant human BDNF 450-02 Peprotech

Recombinant human bFGF/FGF2 100-18B Peprotech

Recombinant human FGF19 100-32 Peprotech

Recombinant human GDNF 450-10 Peprotech

Recombinant human SDF1 300-28A Peprotech

ROCK inhibitor Y-27632 72302 Stem cell technologies

SB431542 S4317 Sigma 

Sucrose S7903 Sigma 

SuperFrost Microscope slides 12372098 ThermoFisher

Tissue-Tek O.C.T. Compound 25608-930 VWR

Tris-HCL 1M T3038-1L Sigma

Triton X-100 9002-93-1 Sigma 

Tween-20 P1379 Sigma 



UltraPure 0.5M EDTA, pH 8.0 15575020 ThermoFisher



Comments/Description

cell detachment medium



iPSC6.2

basement membrane matrix

mounting medium

adhesion microscope slides
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Commented [A1]: This part is not marked for filming. Please ensure that the highlighted 

section is in line with the title of the manuscript and is no more than 2.75 pages including 

headings and spacings and no less than 1 page. Some of the shorter steps can be combined 

in the second section to fit the page limit for highlights. 

 

R.: Some of the steps in the second section were highlighted. 

 

Commented [A2]: We cannot be biased towards a particular product. JoVE cannot publish 

commercial terms. Left one instance here and the details can be moved to the table of 

materials. 

 

R.: We agree. Thank you for the correction. 

 

Commented [A3]: Matrigel changed to generic term. 

 

R.: Generic term was added to comments in the Table of materials. 

 

Commented [A4]: Please include a note stating which specific cells were used for the 

experiments presented here. 

 

R.: Please include in this step: 

NOTE: In this protocol, three distinct human iPSC lines were used: F002.1A.13 (Silva et 

al.,2020), human episomal iPSC line (iPSC6.2) (Burridge et al., 2011) and iPS-DF6-9-9T.B , 

provided by WiCell Bank. 

 

Please add references:  

Silva T.P., Bekman E., Fernandes T.G., et al. Maturation of human pluripotent stem cell 

derived cerebellar neurons in the absence of co-culture. Front Bioeng Biotechnol. (2020) 

doi: 10.3389/fbioe.2020.00070 

 



Burridge P.W. et al. A universal system for highly efficient cardiac differentiation of human 

induced pluripotent stem cells that eliminates interline variability. PLos One, 

6(4):e18293(2011) 

 

Correction:  Manuscript line 144,  correct to:  “(prepared in step 1.1)” 

 

Commented [A5]: Please include a note with citation stating the significance of adding 

ROCK inhibitor prior to seeding in the bioreactor. 

 

R.: Please include in this step: 

 

NOTE: ROCKi is used to protect dissociated iPSCs from apoptosis (Watanabe, K. et al, 2007) 

 

Reference:  

Watanabe, K., Ueno, M., Kamiya, D., Nishiyama, A., Matsumura, M., Wataya, T., Takahashi, 

J.B., Nishikawa, S., Nishikawa, S., Muguruma, K., et al. A ROCK inhibitor permits survival of 

dissociated human embryonic stem cells. Nat. Biotechnol. 25, 681–686 (2007) 

 

Commented [A6]: Changed to generic term. The generic term can be added to the 

comments in the table of materials. 

 

R.: The generic term was added to comments in the Table of materials 

 

Commented [A7]: How is this done? 

 

R.: Please include this NOTE:  

“Set the set point in the universal base unit control at 27 RPM.” 

 

Commented [A8]: How do you check for the dead cells at this point? 



 

R.: Cell death can be observed by the number of single cells that are present in the well.  

For the quantification of cell death different techniques could be used.  

The aggregates from 1mL collected sample could be dissociated using accutase for 7min at 

37ºC.  The proportion of dead cells can be determined by either counting the cells with a 

hemocytometer using trypan blue dye or flow cytometry using LIVE/DEAD 

Viability/Cytotoxicity Kit, following the manufacturer instructions. 

  

Commented [A9]: How is this done? Please include button clicks etc. in the software. 

 

R.: 

Select “Analyze → Set Measurements” from the menu bar and click in “Area” and “OK”. 

Select “File → Open” from the menu bar to open a stored image file. Select the line selection 

tool presented in the tool bar and create a straight line over the scale bar presented in the 

image. Select “Analyze → Set scale” from the menu bar. Introduce in “Known distance” the 

µm corresponding to scale bar of the image. Define the “Unit of length” as µm. Click in 

“Global” to maintain the settings and “OK”. Select oval selection in the tool bar. For each 

aggregate delineate the area with the oval tool. Select “Analyze → Measure”. 

 

Commented [A10]: At what time/day this is observed. 

 

R.: This is observed at day 1, as mentioned in step 3.2. 

 

Commented [A11]: How much time is generally needed? 

 

R.: To reach 200-250 μm in diameter, a maximum of 2 days is required. 

 

Commented [A12]: Is this step same as 3.8.? Please remove the redundancy. 

 

R.: This step is different from step 3.8. In this step FGF2 and SB are not added. 



 

Commented [A13]: Notes cannot be filmed. Removed highlights. 

 

R.: This has been removed. 

 

Commented [A14]: So the vessel containing the cells and the base unit together makes the 

bioreactor? 

 

R.: Please change the term "vessel" to "bioreactor". 

 

Commented [A15]: Please include a note along with citations to show the significance of 

including these factors. 

 

R.: Please include: 

NOTE: SB431542 is crucial to inhibit mesendodermal differentiation, inducing neural 

differentiation (Smith et al, 2008). FGF2 is used to promote the caudalization of the 

neuroepithelial tissue (Yaguchi Y. et al, 2008) 

 

References: 

J. R. Smith et al., Inhibition of Activin/Nodal signaling promotes specification of human 

embryonic stem cells into neuroectoderm. Dev. Biol. 313, 107–117 (2008) 

Yaguchi Y., Yu T., Ahmed M.U., Berry M., Mason I., Basson M.A.. Fibroblast growth factor 

(FGF) gene expression in the developing cerebellum suggests multiple roles for FGF 

signaling during cerebellar morphogenesis and development. Dev Dyn. 238 (8), 2058-2072 

(2008) 

 

Commented [A16]: So, the diameter won’t change a lot after adding gfCDM? Also please 

define. 

 



R.: It is expected that aggregate size increases during the differentiation protocol. However, 

the diameter is only critical when we start the differentiation, because this parameter could 

influence the efficacy of differentiation. 

 

Correction:  Manuscript line 239,  Step 3.11, Please include:  

 

NOTE: FGF19 is used to promote polarization of mid-hindbrain structures (Fischer et al, 

2011). 

 

Reference:  

Fischer T., Faus-Kessler T., Welzl G., Simeone A., Wurst W., Prakash N. Fgf15-mediated 

control of neurogenic and proneural gene expression regulates dorsal midbrain 

neurogenesis. Dev Biol. 350 (2), 496-510 (2011) 

 

Commented [A17]: Significance of adding this here. Please include. 

 

R.: Please include: 

NOTE: Neurobasal medium is a basal medium used to maintain the neuronal cell population 

within the organoid (Muguruma et al, 2015). 

 

Reference:  

Muguruma K., Nishiyama A., Kawakami H., Hashimoto K., Sasai Y. Self-Organization of 

Polarized Cerebellar Tissue in 3D Culture of Human Pluripotent Stem Cells. Cell Rep. 10 (4), 

537-550 (2015) 

 

Commented [A18]: Significance of adding this. 

 

R.: Please include: 

 

NOTE: SDF1 is used to facilitates the organization of distinct cell layers (Bagri A. et al, 2002). 



 

Reference:  

Bagri A., Gurney T., He X., et al. The chemokine SDF1 regulates migration of dentate granule 

cells. Development. 129 (18), 4249-4260 (2002) 

 

Commented [A19]: Significance of adding this. 

 

R.: Please include: 

NOTE: Brainphys is a neuronal medium that supports synaptically active neurons (Bardy C. 

et al, 2015). 

 

Reference:  

Bardy C., van den Hurk M., Eames T., et al. Neuronal medium that supports basic synaptic 

functions and activity of human neurons in vitro. Proc Natl Acad Sci U S A. 112 (20), E2725-

E2734 (2015) 

 

Commented [A20]: Some of the steps from this section can be highlighted. 

 

R.: Some of the steps in this section have been highlighted. 

 

Commented [A21]: At what stage is this done? 

 

R.: Please include:  

NOTE: Organoids should be collected at different timepoints to evaluate the efficacy of 

differentiation, including days 7, 14, 21, 35, 56, 70, 80 and 90. 

 

Commented [A22]: Please remove vertical wheel from the figure. 

 

R.: The term “vertical-wheel” was removed from the figure. 



 

Commented [A23]: Please expand on the limitations of the protocol. 

 

R.: Limitations of the protocol were introduced in lines 561 - 568. Please see the full text 

bellow: 

“Using these dynamic conditions, a more efficient diffusion of nutrients, oxygen and growth 

factors can be achieved, however some limitations can be associated with the agitation 

used in the differentiation protocol. Some shear stress can be introduced by the agitation 

process, which can affect the survival, proliferation and differentiation of cells. Therefore, 

during the maturation step, in which the cells are more sensitive, a careful monitoring of 

the culture must be performed.” 

 

 

 

 

 

 

 

 

 

 

 


